
There are several browsers on the market.  The browser 
will be your connection to the internet.

We will cover one browser in some detail and if you would 
rather use one of the others, you will find that there are 
many similarities and you will not have much trouble 
learning any browser that you want to use.

Windows Internet browser or Internet Explorer, is 
probably the most popular today, because it comes on 
almost all computers sold.

You will find it a good browser, indeed, most browsers 
will do the job, it is usually a matter of personal 
preference.

Netscape is also a good browser, and many people 
really like it.  The Netscape people are quite 
innovative and have nice features.

Firefox is an excellent browser that has all of the 
normal features.

It is free and available for download on the internet. 
There are many “PLUGINS” available also.  The 
plug-in is a little addition to Firefox that makes it easy 
to do certain processes that you might want to add. 
Just go to their website to download them.

If you put your cursor over any of the icons in the bars 
at the top there will be a little window that opens to 
tell you what the icon will allow you to do.

At the top you will see the usual menus File, Edit, 
View, Go, Bookmarks, Tools, and Help.  We will not 
go to each of the items in each menu but I will 
mention some of them so you are aware of what they 



are.

You will see a left and right arrow on the left side of the 
toolbar which move you back one page or forward one 
page.  There may be a tiny arrow between the right and left 
arrows.  This will open up a history of the pages you have 
been to recently.  Click on one of them and you will return 
to that page.

The double arrow in a circle format is the “reload” option. 
If you go to a certain page often, you will want to click on 
this reload button to be sure you have a fresh version of the 
page. 

When the reload button is pressed the browser will force 
the program to go get the page from the internet instead of 
picking it off of the computers hard drive or memory.

Normally the browser will compare the page you have 
presented in the browser with the same page on the internet 
and be sure it is the same page, however this doesn’t 
always happen.  If the pages are different the browser 
should go get the new and updated page for you.

Next there is a stop sign shaped icon with an “X” in it. 
This will stop what is loading from loading any further. 
This is good to know since now and then a page that you 
don’t really want to see will load and you can stop it.

Next to the stop button is the “HOME” button (a little 
house) which will take you to your home page.  The home 
page is the first page that comes up when you open your 
browser.

The address window is where you type in the internet 
address that you want to go to.  Be sure to add the www. at 
the front of the address.  Most of the time this addition will 
get you where you want to go.  If not, add the http:// before 
the www. and see if that works.  Most of the current 
browsers will function with only the www.

Next to the address bar is the search bar.  Just type in what 
you want to search the internet for and it will go find it. 
The little down arrow beside the search engine icon will 
open a menu with other search engines to use.  You can 
also add and remove search engines in some browsers.

If you don’t find what you want on the first search, try 
one of the other search engines since they may list 
what you want.

If you would like to keep the page you have loaded for 
awhile but also want to go to other sites press Control 
key and T and another tab will open up.  This tab will 
act just like another browser.  You can open several 
tabs at a time.  (Some older versions of Microsoft 
Explorer and Netscape do not have this feature.

Under File you will find the usual open, save, save as 
features.  You can save the page to your computer if 
you want.  It will save the page and all pictures and 
items shown on the page.  You can then go to your 
hard drive and look at it any time you wish.

“SEND LINK” will open an email so you can send the 
address of this page to a friend or to yourself if you 
are at a different computer.

You can print the page with PRINT and the Import 
option will allow you to import bookmarks from other 
browsers.

If you install Firefox it will usually find your book 
marks in your old browser and automatically bring 
them into Firefox.  If this does not happen, use this 
feature.

The Edit menu is the normal items you are used to.  

The View menu allows you to set up your taskbars, 
and bookmarks.  There are also other options one of 
which is View Source.

Web pages are basically text files, but they have code 
built into them to tell the browser how the maker of 
the page wants it to be presented.  The code sets the 
font, colors, layout and any other formatting.

In the View source menu you can look at the code and 
text together.  This is handy if you are a webpage 
maker, you can see how to do certain operations.



It is also handy if you don’t know if the link you are about 
to click on is really what it says.

If the link says you are going to http://www.open.org and 
you view source and find that it really is going to 
129.235.9.1 (not a real address, just to illustrate) you will 
want to be very cautious as it may be trouble. 

“Go” allows you to click to where you want to go, 
including to places you’ve been lately.

The Bookmarks button shows operations available to you 
to sort, add and delete bookmarks.

Tools and Help are the normal menus.  Options vary with 
which version of browser you have.

One of the options in tools is Options.  There are many 
settings here and you will need to read the help file to find 
out what they are and how to use them.  Many of them you 
will have no reason to use, but there are a couple that 
should be mentioned.

We have mentioned “cookies” that internet sites place on 
your computer.  One of the options is to delete cookies. 
Do it now and then, but remember if you do you will have 
to log into your forums and sites that require passwords.

The other option is Empty Cache which dumps the storage 
area that fills up with all the information that you view in 
your browser.

Normally you don’t have to worry about it, but if your 
browsing starts to slow down you might empty the cache. 
It sometimes gets filled to overflowing and begins to slow 
the computer down.

To set these options, click on TOOLS/OPTIONS.  Cache is 
on the General tab and Cookies are on the Privacy tab.

The Tabs tab allows you to set up how the tabs in the 
browser operate.

You will not hurt the browser by clicking around so 
experiment.  Slowly you will find how you want it set for 
your browsing pleasure.

1. Internet Security

There are two major areas of security while you are on 
the internet.  In browsing you will be confronted with 
shopping.  If you do any shopping it is best to be sure 
you are doing so on a “SECURE” site.  In the browser 
there is a little padlock icon.  If it is closed it is a 
secure site, if it is open it is not secure.

Most of the time now days secure sites are displayed 
in the address bar with an orange background and the 
http will have an “s” behind it (https://)

Even if it is a secure site beware since you are giving 
this site your personal information and normally a 
credit card number.

If you don’t know a site, check with others and see if 
anyone has experience with it.  Many sites are quite 
well known, such as Amazon.com and Ebay.  These 
sites are secure, but you can still be taken by the 
sellers on Ebay so be careful.

Also be sure to watch your address bar when you click 
on links.  Are you going where the link said you 
would go.  

Your email is the other real danger.  You can follow 
links to false sites that will ask you for personal 
information trying to get your money.

You can also get virus programs that will cause 
troubles for your computer.

http://www.open.org/


When dealing with email, if you don’t know the sender, be 
very careful.  Even if it says it is from a company you do 
business with, don’t just automatically do what they want 
you to do.  

There are tricksters that have many very nice sounding 
ways of getting your money so be very careful.

If you get an email from your bank, call your local branch 
and ask them if this is really from them.

There are thousands of ways to separate you from your 
money, and dozens of others invented every day, so if you 
like your money in YOUR pocket book be very careful.

2. Computer Security:  Even though we are talking internet 
in this section we ought to mention general computer 
security once again.

If you keep your personal information (Social Security 
number, bank numbers, credit card numbers etc.) be sure 
that you secure it.

If your computer is stolen, the thief can access your 
information just as easy as you can.

Most organizer programs can be secured with a password. 
This is an excellent idea.  

If you have a financial program on your computer it most 
likely can be secured by password – again be sure to do it.

You can also set up a user account and put a password on 
it.

Just a word about passwords and what to use or not use. 
Don’t use something easy like your birthday, anniversary, 
or pets name.  Make your password something that a thief 
would not think of – something like your address or name 
would be rather obvious.

While giving you a strong “BE CAUTIOUS!” message be 
sure to enjoy your internet experience.  I personally have 
bought hundreds of items online.  It is convenient and 
saves me a lot of running around town finding the lowest 

prices.  We have never had any security problems 
online, be we are very careful how we operate online.

Ebay is another site that if you are careful is a good 
resource for items you want cheap.  Just be very 
careful to read every word so you really know what 
you are bidding on.  Also be sure you deal with people 
that have very high feedback ratings.  If the rating 
isn’t 100% look at the feedback and see why there are 
bad things being said about the seller.

On Ebay many people view their purchases as “How 
much money am I willing to loose?”  If you bid, win 
and receive something that is terrible, are you willing 
to have lost that money.

I have found that most people selling on Ebay are 
quite reputable, but I may have just been very lucky 
too.  

Most Ebay sellers will work with you to solve any 
problems.  They know their feedback is the total 
reputation that they have online.  Most of them want 
to take care of it and will strive to make you happy.

Be careful is the watch word. 

One further mention of security is needed.  Your data 
is important to you, so be careful to keep it safe.

The passwords you set will help, but if your text and 
pictures are important to you be sure that you back 
them up.

Computers fail, houses burn down, burglars steal 
things and all sorts of terrible things happen.

If you should loose your computer your information is 
gone unless YOU BACK UP!

It is always good to have a copy of your personal data 
backed up to an external hard drive or CDROM.  You 
can then store it someplace away from your home. 
You can store it at a friend’s or relative’s home.  It 
takes little space and it is a good precaution on your 
part.



Personal data is very important to many people, but not so 
important to others.  If you are willing to loose it, then 
caution isn’t needed.  However if you value your 
information, having two backups wouldn’t be too hard to 
do.  I personally have kept three backups for years.  I 
seldom needed three, but a back up has been quite 
important to me several times over the years.

I have thousands of hours of studies that I have done that I 
want my children and grand children to have access to, so I 
am very careful to backup often and in several places.

The following sites are not recommended but are given as 
resources and examples of some of the things that you can 
do on the web.

Pocket PC Magazine site: This is an example of an internet 
forum or board where people come together to discuss 
things of common interest.  This one is related to pocket 
computers and is a great resource to someone having 
problems with a unit.  Few people use their real name. 
They use a screen name so that security isn’t an issue.  Just 
do not give personal information and you should be safe. 
http://www.pocketpcmag.com/forum/

Microsoft site: The Microsoft site has a lot of resources to 
assist you with their products and they also offer many 
downloadable programs to update our products.  There are 
also a few free items if you do some searching. 
http://www.microsoft.com

Wikipedia Encyclopedia site: Wikipedia is an online 
encyclopedia that is rather unique.  Anyone can add to the 

information on Wikipedia and it is made available to 
everyone.  Normally the information is quite accurate, 
but be careful because you don’t know who is putting 
information there. 
http://en.wikipedia.org/wiki/Main_Page

There are other online encyclopedias available, but 
not all are free.

Google site:  Google is a very popular search engine, 
but they are expanding into other areas as well.  It 
might be worth your time to go to their main site and 
just snoop around.  

One of the new items is a satellite mapping area where 
you can see satellite views of any area in the world, 
and then zoom in to much closer views.  (Broadband 
is required for this service.)  http://www.google.com

Quest Dex site:  This site is an online phone book and 
is usually quite good and a very handy tool to use. 
http://www.dexonline.com/cgi/search.fcg?from=QWE
STRES

There are also phone sites called backward sites that 
allow you to type in the phone number and the site 
will then give you the name and address of the phone 
number if there is a listing.

Open.org ISP: Open.org is the city’s internet service 
provider.  This service has been available for several 
years and is fairly inexpensive. 
http://www.community.open.org

cityofsalem.net:  If you are interested in the city and 
its operation this site is full of information.  They have 
info from the city council, the neighborhood 
associations and from each of the governmental 
agencies.  

You can report items you think the police might be 
interested in as well as graffiti.
http://www.cityofsalem.net

Salem Keizer Community Development Corp.: 
http://www.salemcdc.org/

http://www.salemcdc.org/
http://www.dexonline.com/cgi/search.fcg?from=QWESTRES
http://www.community.open.org/
http://www.dexonline.com/cgi/search.fcg?from=QWESTRES
http://www.dexonline.com/cgi/search.fcg?from=QWESTRES
http://www.google.com/
http://en.wikipedia.org/wiki/Main_Page
http://www.microsoft.com/
http://www.pocketpcmag.com/forum/


Ebay:  http://www.ebay.com

Paypal:  Paypal is a system whereby you can pay for Ebay 
purchases online securely.  Many other online businesses 
are now accepting Paypal payments as well.

You go to Paypal’s site and register, give them a bank 
account or credit card and they will set up an account for 
you.  When you make a purchase you will be transferred to 
the Paypal site to make your payment.  That way the seller 
has none of your information except your address where 
they will send the product.
http://www.paypal.com

Memoware:  this site has many ebooks online for 
download.  You just need to go and look around to see the 
variety of books.   You can search for a book by title or 
author.

The books come in different formats, and if you don’t have 
the reader you need, they have links to the reader websites 
so you can download the reader. 
http://www.memoware.com/   There are also other sites for 
free books online.

Hotmail:  Hotmail is a free email service that is fairly 
reliable.  Just go to their site and sign up and you will have 
email access.  There are a number of other free services as 
well.
http://www.hotmail.com

Statesman journal: This is the local newspaper for free. 
Just go to the site and most of the printed paper is online. 
You can also search for past items as well. 
http://www.statesmanjournal.com

Yahoo:  Yahoo is another popular free email service, but 
like Google they are expanding into other areas that you 
might find of interest.  http://www.yahoo.com/

TV Channel 8:  All of the main channels have websites 
online.  Some of them require you sign up for a free 
account, others have no registration requirement.  This is 
channel 8’s website.  http://www.kgw.com/

Webcams:  There are thousands of webcams online. 
This is just one site that has many cameras listed.  A 
webcam is just a camera that is aimed at something 
and hooked to the internet so others can see what the 
camera sees.

You want to be careful since there are things on 
cameras that you might not want to see.

There are cameras on top of buildings so you can see 
the streets below, there are cameras aimed at animals, 
at closed stores, open stores, malls, beaches etc.

Some of them you can control so that you can look 
around with the camera.

You can watch what is going on in Estonia or London 
any time of day.  It is interesting if you have a little 
time to waste. 
http://search.earthcam.com/search/ft_search.php?s1=1
&term=oregon

Fitness Training: There are hundreds of fitness 
websites as well as health sites.  Be careful what you 
accept as valid, anyone can put these sites up.  

http://www.thetrainingstationinc.com/
is a fitness site, while http://www.webmd.com is a 
medical site that you might find of interest.

There are other medical websites that have good 
information as well.  The Mayo Clinic and other 
hospitals have large websites that can be good 
resources for you.

Genealogy:  If you have interest in finding 
information about your family this site as well as 
many others online will have hints and information 
that will assist you.  Sadly a number of these sites 
cost, so beware to look around before getting too 
excited.  Just Google for genealogy and you will find 
other sites.
http://www.usgenweb.org/

Job finding:  If you are looking for work, this is the 
classified ads at the Salem paper.  There are a couple 

http://www.usgenweb.org/
http://www.webmd.com/
http://www.thetrainingstationinc.com/
http://search.earthcam.com/search/ft_search.php?s1=1&term=oregon
http://search.earthcam.com/search/ft_search.php?s1=1&term=oregon
http://www.kgw.com/
http://www.yahoo.com/
http://www.statesmanjournal.com/
http://www.hotmail.com/
http://www.memoware.com/
http://www.paypal.com/
http://www.ebay.com/


of other Salem sites as well as nationwide sites. 
http://statesmanjournal.gannettonline.com/careerbuilder/in
dex.html

One of the more popular national sites is 
http://www.monster.com

Office Depot:  Most of the major retailers have online sites 
as well.  Most offer online purchase.  Some allow you to 
purchase online and pick up at the local store.  I will list 
some that I have looked into.

http://www.officedepot.com/

http://www.bestbuy.com

http://www.officemax.com

http://www.circuitcity.com

http://www.target.com

There are thousands of sites that might interest you.  There 
are free books, maps and just about anything you want to 
see or read about on the net.  Just do a Google and you will 
find tons of stuff.

CLASS SESSION 5

As with browsers there are several email programs that are 
all equally good, just pick one that fits how you want to 
work.

Outlook express comes with most computers right 
now.  Others are very similar so if you learn one, you 
should be able to run any of them.

Outlook Express is a watered down version of 
Outlook.  Outlook will be the concentration of our 
comments.  If you can run it Express and the other 
email programs should be easy for you to pick up and 
use.

The first thing to do is to get an email account.  To do 
this you need to either purchase internet service from 
a provider like AOL, Earthlink or Netzero or any of 
the other providers available.

There are also free email services that have been 
mentioned, so just pick the service that is best for you.

Once you have the service you can set up your email 
program and get started.

http://www.target.com/
http://www.circuitcity.com/
http://www.officemax.com/
http://www.bestbuy.com/
http://www.officedepot.com/
http://www.monster.com/
http://statesmanjournal.gannettonline.com/careerbuilder/index.html
http://statesmanjournal.gannettonline.com/careerbuilder/index.html


The address book is where you keep all of your 
information to contact people with.

Go to Tools and click on Address book.  Here you can 
enter email addresses, snail mail addresses and a lot of 
other information about your contact. 

To add a contact, click on the icon that looks like a rolodex 
card.  Then just proceed to enter the information you have.

Once you have your address book set up you can add, 
remove, or change any of the information by finding the 
contact, right clicking for the option and choose properties.

You can choose to use the Outlook address book or the 
Address book that is built into Windows.  The option is 
one of the windows in the Address book window you open 
from Outlook.

Outlook will have some folders set up for you, but if you 
want to sort your mail further you can set up other folders 

as well.

Go to File and choose NEW and then choose 
FOLDER.  It will ask you for a name.

If the folder is not where you want it or if you want to 
rearrange the folders, just click and hold on the folder 
you want to move and drag it to the new location.

When your folders are set up, you can then just click 
and hold on an email and drag it to the folder where 
you want it. 

In some email programs you can find an option to 
“VIEW SOURCE.”  This allows you to see the code 
that comes with the email message.  

This can be handy if you have an email that is from 
someone that you do not know.  If there is a link on 
the email, if you view source the address should be the 
same as in the email.  If it is not it is probably a scam 
of some sort.



If you want to store your emails, you can move them to 
another location so that you don’t have to look through 
months of email to find one you received last week.

Just go to the folder that you want to save, click on 
CONTROL A to select all (or go to Edit and Select All) 
then go to File and choose Save As.  A window will open 
and you can save all of the messages as one big text file 
which you can open later and use the “FIND” function of 
the word processor to find the message you are looking for.

There are many changes you can make in options, just go 
slowly and read the messages.  If you have a question 
about the option, check the help file before you make any 
changes.

If you sign up with AOL or one of the major 
companies, they will normally send you a CD with the 
programs on it.  You just install it and it will set up 
most of your items automatically.

If you have problems their online help should take 
care of them.

If you sign up with Hotmail or Yahoo, you just open a 
browser, and type in the address and check your mail.

If you have a local internet provider there is a little 
more of a process to go through.

Go to Tools and Email accounts.  There is a series of 
options for you.  Just click on Add and it will step you 
through what you need.  

When you sign up, the service provider should give 
you the information that you should enter.

You will need an address for incoming mail as well as 
one for outgoing mail plus your name and password.

Once this is set up you are ready to start emailing.



Spam is any unwanted email.  After you have been on the 
net awhile you will start getting lots of it so do not be 
surprised when it happens.

There are several ways to cut down on spam other than not 
giving your email address out to anyone.

There are filters available in Email programs that allow 
you to set up a list of words that you do not want to get 
through.  If an email contains these words it will 
automatically go to the trash. 

The problem with this is that if someone you know uses 
that word, their email will also go to the trash so check the 
rejected email now and then to be sure it didn’t make a 
mistake.

You can buy programs to eliminate spam.  The workability 
of these programs is not within my experience.

Some service providers can take your address book and 
compare it to incoming mail and reject all that is not 
coming from someone you know.

The problem is that anytime you add someone to your 
address book you will have to contact the provider and 
update the list he has on file.

Calendar is a part of Outlook and can be quite handy. 
It will keep track of birthdays, anniversaries, 
appointments and any other event that you want to 
remember.

Somewhere in your folders there is one labeled 
Calendar and just click on it.  Just enter your event on 
the date and time and it will be stored for you.

There are options so that the program can give you an 
alarm before the even if it is an appointment. 

There is also a “TODAY” screen that will list your 
happenings for the day on one screen.

Most pocket computers can be hooked to your main 
computer and all this information can be transferred to 
the pocket unit.  That way you have your information 
anywhere you go.

If you update, add or remove information from either 
computer the information will be compared and 
updated the next time the units are connected.  (Be 
sure to read the syncing software help file to set up 
how you want the two units to communicate with one 
another.)

B. Microsoft Outlook

Outlook is the commercial email program from 
Microsoft and is quite similar to Outlook Express.  

There are other Email programs around if you don’t 
feel that you like one of the Outlooks.



Word processors are programs that allow you to create 
letters and documents.  There are many different word 
processors available.  Most are similar to operate so only a 
few will be covered.

The main difference in programs is in the amount of things 
you can do with them.  The cheaper programs have fewer 
options in relation to style and look of the documents.

Notepad is the simplest of word processors, and Word Pad 
has options available.

Notepad is just a plain little program that does very well at 
what it does.

It has the normal open, new, save and save as options.  The 
only menu item of note is “word wrap” in the Format 
menu.

Word wrap is a tool of formatting.  If it isn’t on, you will 

get one long line in your notepad window.  As you 
type the line gets longer and longer.  With Word wrap 
turned on the program will break the line at the edge 
of the window and start another line so that you can 
see all of your text in the window.  This is a left over 
feature that has been around for years in notepad. 
Most word processors automatically do this for you.

Word is the most popular of Microsoft word 
processors for office use.  Microsoft Works may be 
more popular for home use due to its being less 
expensive.

Word is the top of the line in Word processors and 
you can do great things with it.  There are other top 
end processors on the market as well which we will 
just mention later.  All processors have similar 
features and options.  It is just a matter of locating 
where they are.  This is what the HELP file is for.

The options and abilities of these word processors are 
much too large a topic for this work.  Some of the 
features and possibilities of the programs will be 
listed.

If you want further training go online and search for a 
Word tutorial or Word Perfect tutorial.  There are 
many books on the subject as well.  The public library 
will most likely have some help books as well as 
online sources.

With Word you can create many types of documents. 
If you go to the File menu and click on New a window 
will open to show the possible documents via 



“TEMPLATES” which will help you to find just the 
document you want.

You can create basic web pages, posters, letters, reports 
and other items.

Within the Tools menu there is an Options menu that will 
allow many changes in the program to make your word 
processing easier.

Word is able to do a lot of formatting automatically and 
there is an options menu to allow you to control just how it 
automatically formats.

The program can spell check your document as you type, 
and to some extent auto correct your typographical errors.

The grammar checker can also check as you type. 
Anything that is questionable will be underlined with a 
squiggly green line.  The spelling errors will have a 
squiggly red line under them.

If you right click on one of these marked errors you will be 
given choices as to how to correct the error.

As with most programs if you hover over an icon an 
explanation will appear to tell you what you can do by 
clicking it.

There are a number of printing options offered within the 
program.

You can insert and resize pictures and clip art to add to the 
appearance of your work.  This publication is a good 
example of what Word can do.  It was created entirely 
within Word.

Clips from spreadsheets can be inserted so that you can 
share numerical information with the reader as well.

If you are creating a document to share with a group or 
club, you can set the program up to insert the members 
name and address at the beginning of the document and the 
program will print out a copy for every member with their 
individual information on it.

Drawings and designs from other programs can be 
inserted and manipulated.

All sorts of formatting tools and fonts are available to 
make the documents look as nice as possible.

Bloggers can create their blog within Word and 
publish to the net.

The features are many and varied.  Let it suffice to 
say, that Word can create just about anything that you 
want to in the way of a document.  This includes page 
numbering, footers, headers and a ton of other options. 

Word Perfect comes in a suite of office programs and 
is a very good set of programs.  It is quite comparable 
to Word.

One comment might be made regarding the Grammar 
checker in Word and Word Perfect.

As far as I can tell from searching online the grammar 
checker in Word Perfect is much better than the one in 
Word.  Word has not updated their program in this 
area from what I can tell.

It has been my observation that both have problems.  I 
have used both grammar checkers extensively and 
what one misses the other often finds, so if you want 
to be as good as can be, use both.



Open office is a suite that is most likely on a level similar 
to Microsoft Office and Word Perfect.  The best part is that 
it is free.

I’m sure there are some options it does not have but for 
free it is an awesome program.  It should be adequate to 
most home uses if you want to save a lot of money.


